
UNDERSTANDING FUNCTIONS IN EXCEL
Functions Overview

Functions are simply pre-programmed formulas already provided for you in Excel which can perform
calculations covering a wide range of categories including statistics, date and time arithmetic, financial
calculations, lists, engineering, and more.
Just like normal formulas that you create, functions must start with an equal sign. The equal sign is
then followed by the name of the function (usually a descriptive name which indicates the purpose of
the function). Most functions also require additional information known as arguments which are
supplied to the function in brackets after the function name. Functions are therefore written as
follows:

=name(arguments)
The arguments are quite often cell or range references that contain values that can be used in the
function. For example, the commonest function is the SUM function which, as its name suggests, is
used to sum or add values together. If you wanted to add all of the values in the cells from B10 to
D15you would write this function as:
=SUM(B10:D15)
As you can see this is much simpler than writing your own referential formula which would look like:
=B10+B11+B12+B13+B14+B15+D10+D11+D12+D13+D14+D15
Imagine writing and proofing a formula where you had to add 200 cells!

Typing Functions
If you are familiar with the function that you need you can type it into a cell exactly the same way you
type any other formula. If you are not sure if Excel has a function or you can’t quite remember how it is
written you can use the Insert Function tool on the Formula Bar to assist you. When you click on
this tool the Insert Function dialog box will be presented to you which lists the most recently used or
common functions and also allows you to search for other functions that you might need.

The Insert Function dialog box will also type the function out for you and then provide you with a
further dialog box to guide you through the process of specifying the arguments that the function
needs to perform its calculation.
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USING THE SUM FUNCTION TOADD
Microsoft Excel

One of the most used functions is the SUM
function. This function allows you to add the
values in a range of cells. The function is
writtenas: =SUM(range or ranges to add).

You can type the function, and then use the pointing
technique to fill in the arguments. Excel then paints
marquees around the cells involved helping you to track
your progress.

For Your Reference…
To type a sum function for a contiguous range:

1. Type =sum(
2. Select the range of cells
3. Type )

4. Press

Handy to Know…
 You can also use the Sum command in

theEditing group on the Home tab of the
Ribbon to have Excel automatically enter
asum function based on a range of cells.

 You can also type the name of a function in
upper or lowercase – it is not case
sensitive.

Try This Yourself:

Before starting this exercise
you MUST open the file E710
Formulas_4.xlsx...

Click on B9 then type =sum(
to start the formula

Click on B6 to point to this
cellas the start, hold down
the key and click on B8
Notice the relative addressing
details, 3R x 1C, that appear in
the tool tip…

Type ) and press
complete the

to

Click on B9, then move the
mouse pointer to the fill
handleon the lower right
corner of thecell and drag
across to E9 to fill the
selected range with the
equivalent functions
Click on the Copy command

on the Clipboard group
on

the Home tab

Click on B14, hold down
Release and press
to paste equivalent
functionsinto the worksheet
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CALCULATINGANAVERAGE
Microsoft Excel

The AVERAGE function allows you to average
the values in a range of cells. It is written in
much the same way as the SUM function, for
example,
=AVERAGE(range of cells to average). The

average function can be applied using the
Functions Wizard, a part of Excel that steps you
through the process of creating a function or you
can type it in yourself if you are comfortable with
it.

Try This Yourself:

Sa
m
e

Fi
le

Continue using the previous file
with this exercise, or open the
file E710 Formulas_6.xlsx...

Click on B29 then click on
theInsert Function tool
to display the Insert
Function dialog box
Click on AVERAGE in Select a
function then click on [OK] to
display the Function
Arguments dialog box
Click on the Range Selector
tool for Number1 to roll up
the wizard, then hold down
and select the following ranges
B6:B8
B11:B13
B16:B18
B21:B23

Press to complete the
range specifications, then click
on [OK] to complete the
process
Let’s use the AutoSum
function…
Click on B34, then click on the
drop arrow for the Sum
command on the
Editinggroup, then select
Average

Click on B9, hold down
andclick on B14, B19 and B24,
thenpress to complete the
formula

For Your Reference…
To insert an average function:

1. Click in the cell then click on the
InsertFunction tool

2. Click on AVERAGE in Select a function
3. Insert the required ranges then click on

[OK]

Handy to Know…
 You can type queries like “How do I work

outthe monthly payment for a car loan?”
into theSearch box in the Insert Function
dialog box. Once you have selected a
function fromthe Select a function list, the
Function Arguments dialog box will help
you to enter the values into the function.
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For Your Reference…
To insert a minimum function:

1. Click in the cell then click on the
InsertFunction tool

2. Click on MIN in Select a function
3. Insert the required ranges then click on

[OK]

Handy to Know…
 You might use a Minimum function in real

life to find the lowest value in a large range
ofnumbers. For example, in a large inventory
itcan be used to work out which product is
the slowest seller.

FINDING AMINIMUM VALUE
The Minimum or MIN function allows you to
extract the lowest value from a range of values.
Itis written in much the same way as the SUM
function. For example, =MIN(range of cells).

The function can be applied using the Function
Wizard, or by typing the function in detail
directlyinto the cell.

Try This Yourself:

Continue using the previous
file with this exercise, or
open the file E710
Formulas_8.xlsx...

Click on B31 then click
onthe Insert Function
tool
to display the Insert
Function dialog
box

Click on the drop arrow
for the Or select a category
box and click on Statistical

Scroll down and click on
MINin Select a function
then click on [OK] to display
the Function Arguments
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tool to roll up the
wizard,then hold down and

select the following
ranges:
B6:B8
Press

B16:B18
B21:B23

to complete 6
range specifications, then
click on [OK] to complete
theprocess
Let’s simply type the function
this time…

Click on B36 and type
=MIN(B9,B14,B19,B24)
Press
formula

to complete
the 7
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Counting and Totalling by Criteria
Occasionally you may need to create a total that only includes certain cells, or count only certain
cells in a column or row. The only way you could do this is by using functions that have conditions
built into them. A condition is simply a test you can ask Excel to carry out, the result of which will
determine the result of the function.

=SUMIF

You can use this function to say to Excel, “only total the numbers in the Total column where
theentry in the Course column is “Word Intro”.

The syntax of the SUMIF() function is
detailed below:
=SUMIF(range,criteria,sum_range)

Range is the range of cells you want to test.
Criteria are the criteria in the form of a
number, expression, or text that defines
which cells will be added. For example,
criteria can be expressed as 32, "32",
">32","apples".
Sum_range are the actual cells to sum. The cells in sum_range are summed only if their
corresponding cells in Range match the criteria. If sum_range is omitted, the cells in Range
aresummed.
Using the example above the SUMIF() function would be as follows:
=SUMIF(B4:B30,"Word Intro",C4:C30)

=SUMIFS()

This function allows you to be more specific about which cells summed, by having more than one
criteria range. For example, you may want to find out total attendees for the Word Intro courses
justfor the beginning of January (dates before 15/1/2013). The syntax is:
SUMIFS(sum_range, criteria_range1, criteria1, [criteria_range2, criteria2], ...)

Using the example above the SUMIFS() function would be as follows:
=SUMIFS(C4:C3,B4:B30,"Word Intro",A4:A30,"<15/1/2013")

=COUNTIF

The COUNTIF function allows you to count those cells that meet a certain condition. The
functionsyntax is as follows:
=COUNTIF(range,criteria)
Range is the range of cells from which you want to count cells.
Criteria are the criteria in the form of a number, expression, or text that defines which cells will be
counted. For example, criteria can be expressed as 32, "32", ">32", "apples".
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With our example (shown above), the COUNTIF function you could use to determine the number
ofWord Intro courses run would be:
=COUNTIF(B4:B30, “Word Intro”) or =COUNTIF(B4:B30, D4) (if D4 contains ‘Word Intro’)

=COUNTIFS()
The COUNTIFS function allows you to count cells that meet more than one condition. The syntax is:
COUNTIFS(criteria_range1, criteria1, [criteria_range2, criteria2]…)
For example, if you had a 3 month schedule of courses, you may want to count the number of
WordIntro courses which run in February only:
=COUNTIFS(B4:B30,"WORD INTRO",A4:A30,">31/1/13",A4:A30,"<28/2/13")
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Calculations with Dates
Excel also allows you to perform calculations with dates. All dates are stored in Excel as sequential
numbers. By default, January 1 1900 is serial number 1, and January 1, 2004 is serial number 40933
because it is 40,933 days after January 1, 1900. Excel stores times as decimal fractions because
time is considered a portion of a day.
Because dates and times are values, they can be added, subtracted, and included in other
calculations. You can view a date as a serial value and a time as a decimal fraction by changing
theformat of the cell that contains the date or time to General format.
Viewing Dates as Numbers

To view dates as numbers:
1. Select the cell and click Cells on the Format menu.
2. Click the Number tab, and then click Number in the Group box.

Calculating the Difference Between two Dates

In the following example the date in cell B1 has been subtracted from the date in cell B2. The
resultin cell B3 has been formatted to display a number (the number of days between two dates)
with no decimal places.

NB: You will need to format the result of the formula to a number format, as it may display as a date.
If you want to know what the date is 3 weeks’ time, and you have the current date in cell A1,
thenyour formula could be:
=A1+21

Date Functions

Excel won’t recognise a date just typed in directly into a formula: Eg =12/1/2012+21. You would
have to use a date function to convert the date into one that Excel can understand as below:
=DATE
=Date(2012,1,12)+21 The arguments being: (year,month,day)
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=TODAY
=TODAY() Current date – this is a dynamic date (will change every day). You could use this in a
formula to see what the date will be in 3 weeks’ time from today’s date: =Today()+21

=NOW
=NOW() Returns the current time. Recalculates as the sheet recalculates. To force a recalculation,
press F9.

=MONTH
=MONTH(date) Returns the month as a number from 1 (January) to 12 (December)

=DAY
=DAY(date)
Returns the day of the month as a number from 1 to 31

=YEAR
=YEAR(date)
Returns the year as an integer. From the year 1900 to 9999

Adding Months and Years to a date

Adding months using the above method won’t be accurate, given than the number of days in a
month varies. The below function will add a precise number of months to any given date. Using
cellB1 in the above example, the function will calculate what the date will be in 3 months’ time
from 4/1/2012:

=DATE(YEAR(B1),MONTH(B1)+3,DAY(B2))

Adding Years to a date
You can use the above function and add the number of years to the ‘YEAR’ part of the function. For
example to add 5 years to the date in cell B1:
=DATE(YEAR(B1)+5,MONTH(B1),DAY(B2))
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Text Functions
=CONCATENATE

You can join the contents of cells together using & (ampersand) symbol.
Eg. =A1&B2 will result in haroldgreen. To include a space in between, you will need to add the
space in as another argument:
=A1&” “&B2

As this can be laborious if you have several cells to join together, there is a function called
CONCATENATE to help. You can join up to 255 separate arguments.
This function takes a series of text arguments separated by commas and joins them together to
create a string. Arguments can be cell references, numbers or text. In the example below, we want
column D to say “Harold Green is aged 75”, “Violet Brown is aged 77” etc

We can use CONCATENATE to achieve this as follows:
=CONCATENATE(A2," ",B2,"is ",C2)

The Function Arguments dialogue box will look like this:
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=TRIM

Removes all spaces from text except for singe spaces between words. Use TRIM on text that
youhave received from another application that may have irregular spacing.

=TRIM(text)

Text is the text from which you want spaces removed. This is usually a cell ref.

=PROPER

Converts a text string to proper case. The first letter of each word is a capital, the rest is in lower
case:

=PROPER(text)

Text is the text from which you want to convert to proper case. This is usually a cell ref.

=UPPER

Converts a text string to all upper case (capital) letters:

=UPPER(text)

Text is the text from which you want to convert to upper case. This is usually a cell ref.

=LOWER

Converts a text string to lower case.

=LOWER(text)

Text is the text from which you want to convert to lower case. This is usually a cell ref.

You can combine the above case conversion functions with the concatenate function to always
havea text string in the case you want:

= PROPER(CONCATENATE(A2," ",B2,"is ",C2))

The above function will result in:

Harold Green is 75
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=LEFT, =RIGHT

Returns the specified number of characters from a text string, starting from the left:

=LEFT(A3,5) will return 57003. These are the
first five characters in Cell A3, starting from
theleft.

=RIGHT(A3,5) will return 697/1. These are the
last five characters in Cell A3, starting from
theright.

.

=MID

=MID returns the middle characters from a text string, given a starting point and how many to
returnfrom that point:

=MID(A3,7,2) will return 69. These are the two characters to the right of the 7th character.

=LEN

=LEN will return the number of characters in a string.

=LEN(A3) will return 11. There are 11 characters in Cell A3
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Logical Functions
=IF

=IF checks if a condition is met and returns one value if TRUE, and another value if FALSE

Eg
1. =IF(A1>10,"Over 10","10 or less") returns "Over 10" if A1 is greater than 10, and "10 or

less"if A1 is less than or equal to 10.

2. =IF(C5+D5>=100,"Pass","Fail") returns “Pass” if the sum of C5 and D5 is 100 or more, and
“Fail” if the result is less than 100.

The Function Arguments would be:

Value-if-true and Value-if-false can be Text, Values or Calculations/Formulae.
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Nested IF

You may want to evaluate more than one condition, and therefore, result in more than one
outcome.You can have up 64 nested IF functions in Excel 2007.

Eg =IF(C5+D5>150,"A",IF(C5+D5>=100,"B","Fail"))

IF C5+D5 is greater than 150, then the result will be “A”, if C5+D5 is greater or equal to 100, then
theresult will be “B”, if C5+D5 is less than 100 (this is only other number it could be!) then the result
is “Fail”

In Excel 2007 onwards you can have up to 64 nests!

=AND

You may have more than one condition to meet for your logical test to be true. You can Nest the
AND function inside the IF and have up to 30 conditions to be evaluated.

EG The students ONLY get a Merit if they gain more than 80 marks for both Part 1 AND Part 2 of
theAudit Exam:
=IF(AND(C5>80,D5>80),"Merit","")
Only the students who have achieved over 80 marks in both exams will gain a Merit
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=OR

If you have more than one condition, but any can be met for the result to true, then use OR.

=IF(OR(C5>80,D5>80),"Merit","")
The students who have achieved over 80 marks in Audit Exam Part 1 OR Part 2 will gain a Merit

=NOT

Reverses the true value. Eg:
=IF(NOT(C5=50,”OK”,””) will return “OK” as C5 does = 50, but none of the other cells in the
ColumnC have the value 50, therefore the result will be “blank” for the rest of the column.
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=VLOOKUP

The VLOOKUP function will look up a value in the first column of table, and returns the value in
thesame row from a column that you specify.

Range called
SALARY

In the above example =VLOOKUP(E5,SALARY,2) looks at value in cell E5 (34), looks for this value
in the first column in the range “SALARY” and returns the value in column 2 of that range.

=HLOOKUP

=HLOOKUP is as the VLOOKUP function, but looks up the value in first row of a range, instead
ofthe first column.
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Maths Functions
Maths functions are in the Math & Trig category in the Formulas tab:

=ROUND

=ROUND if useful to force the result of a calculation to be a specific number of decimal places.
Unlike number formatting, which just changes what the number looks like, but retains the accuracy
ofthe original calculation, and if this value is then used in other formulae, it may result in rounding
errors.
Eg =ROUND(2.3165,2) Result will be 2.32

This can be nested into another function: For example:

=ROUND(C5*12.5%,2)

Will round to 2 decimal places the result of the calculation C5 multiplied by 12.5%

=INT

=INT rounds the number to the nearest integer

=INT(2.3165)

Will return the integer part of the value – the result will be 2.

Understanding error messages

Excel may display error messages if your formulae or functions contain mistakes (note that it will
notdetect all errors in calculations). It is always worth checking the result of your formulae by hand
if theformula is at all complex. Excel’s error messages contain a # symbol followed by a diagnostic
word (see the table below). In some cases, the cell with an error in it has a small green arrow in the
corner. In such cases, if you click in the cell a yellow symbol with an exclamation mark appears.
Click the exclamation mark for options to help you to trace the source of the error.

Green triangle Cell containing error

messageYellow symbol with exclamation mark

Options for dealing with error
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Conditional Formatting
Conditional formatting will format cells to your specifications or to preset formats, which match the criteria that
you specify. For example, you may want to highlight all the cells that have a value higher than 80 in a red font with
a yellow background.

1. This is a cell formatting feature, so you need to select the cell range which you want to
affect first. Then click on the Conditional Formatting button in the Styles group on the
Home tab.

2. On the Highlight Cell Rules option, choose the criteria required. Eg Greater Than, and
specify80 as the value and then choose from the list of formats offered, or create your own
with Custom Format...
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You can also use text criteria – cells which contain certain text strings (Text that Contains...)

Dates occurring in differing date/time frames :
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Conditional Formatting using a Formula
You may want to make your Conditional Formatting more dynamic by using cell references in your
criteria. So when the content of the cell(s) change, the formatting will also change.
In the example below, the cells which contain values greater than or equal to the value in cell G5, the
colour fill will change.

To use a formula:
1. Select the cell range you wish to apply the rule to
2. Click on Conditional Formatting, New Rule and select
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3. Select the cell (or type in the cell reference) at the beginning of your range – in this example cell
G5. Make sure that it is NOT absolute

4. Complete the formula using the cell which will contain your variable value – G1 (this cell must be
absolute)

5. Set the Format as required

Clearing Conditional Formats

You can clear all Rules by selecting Clear Rules on the Conditional Formatting button or be selective in
the Rules you wish to delete or edit with the Manage Rules Option



Statistical Functions
S/N FUNCTION CATEGORY DESCRIPTION USAGE

01 SUM Math & Trig Adds all the values in a range of cells =SUM(E4:E8)

02 MIN Statistical Finds the minimum value in a range
of cells =MIN(E4:E8)

03 MAX Statistical Finds the maximum value in a range
of cells =MAX(E4:E8)

04 AVERAGE Statistical Calculates the average value in a
range of cells

=AVERAGE(E4:E
8)

05 COUNT Statistical Counts the number of cells in a range
of cells

=COUNT(E4:E8)

06 LEN Text Returns the number of characters in a
string text =LEN(B7)

07 SUMIF Math & Trig
Adds all the values in a range of cells
that meet a specified criteria.
=SUMIF(range,criteria,[sum_range])

=SUMIF(D4:D8,">
=1000",C4:C8)

08 AVERAGEIF Statistical

Calculates the average value in a
range of cells that meet the specified
criteria.
=AVERAGEIF(range,criteria,[averag
e_range])

=AVERAGEIF(F4:
F8,"Yes",E4:E8)

09 DAYS Date & Time Returns the number of days between
two dates

=DAYS(D4,C4)

10 NOW Date & Time Returns the current system date and
time =NOW()



Numeric Functions
As the name suggests, these functions operate on numeric data. The following table shows some
of the common numeric functions.

S/NFUNCTIONCATEGORYDESCRIPTION USAGE

1 ISNUMBER Information Returns True if the supplied value is numeric
and False if it is not numeric =ISNUMBER(A3)

2 RAND Math & Trig Generates a random number between 0 and 1 =RAND()

3 ROUND Math & Trig Rounds off a decimal value to the specified
number of decimal points =ROUND(3.14455,2)

4 MEDIAN Statistical Returns the number in the middle of the set
of given numbers =MEDIAN(3,4,5,2,5)

5 PI Math & Trig Returns the value of Math Function PI(π) =PI()

6 POWER Math & Trig Returns the result of a number raised to a
power. POWER( number, power ) =POWER(2,4)

7 MOD Math & Trig Returns the Remainder when you divide two
numbers =MOD(10,3)

8 ROMAN Math & Trig Converts a number to roman numerals =ROMAN(1984)



String Functions
These basic excel functions are used to manipulate text data. The following table shows some of
the common string functions.

S/
N

FUNCTI
ON

CATEGO
RY DESCRIPTION USAGE COMMENT

1 LEFT Text
Returns a number of specified
characters from the start (left-hand
side) of a string

=LEFT("GURU99",
4)

Left 4 Characters
of "GURU99"

2 RIGHT Text
Returns a number of specified
characters from the end (right-hand
side) of a string

=RIGHT("GURU99
",2)

Right 2
Characters of
"GURU99"

3 MID Text

Retrieves a number of characters
from the middle of a string from a
specified start position and
length. =MID (text, start_num,
num_chars)

=MID("GURU99",2,
3)

Retrieving
Characters 2 to 5

4 ISTEXT Informatio
n

Returns True if the supplied
parameter is Text =ISTEXT(value) value - The value

to check.

5 FIND Text

Returns the starting position of a
text string within another text string.
This function is case-
sensitive. =FIND(find_text,
within_text, [start_num])

=FIND("oo","Roofin
g",1)

Find oo in
"Roofing",
Result is 2

6 REPLAC
E Text

Replaces part of a string with
another specified
string. =REPLACE (old_text,
start_num, num_chars, new_text)

=REPLACE("Roofi
ng",2,2,"xx")

Replace "oo"
with "xx"



VLOOKUP function

The VLOOKUP function is used to perform a vertical look up in the left most column and return
a value in the same row from a column that you specify. Let's explain this in a layman's
language. The home supplies budget has a serial number column that uniquely identifies each
item in the budget. Suppose you have the item serial number, and you would like to know the
item description, you can use the VLOOKUP function. Here is how the VLOOKUP function
would work.

=VLOOKUP (C12, A4:B8, 2, FALSE)

HERE,



 "=VLOOKUP" calls the vertical lookup function
 "C12" specifies the value to be looked up in the left most column
 "A4:B8" specifies the table array with the data
 "2" specifies the column number with the row value to be returned by the VLOOKUP

function
 "FALSE," tells the VLOOKUP function that we are looking for an exact match of the

supplied look up value

The animated image below shows this in action



IF, AND, OR, Nested IF & NOT Logical Functions in Excel

What is a Logical Function?

It is a feature that allows us to introduce decision-making when executing formulas and
functions. Functions are used to;

 Check if a condition is true or false
 Combine multiple conditions together

What is a condition and why does it matter?

A condition is an expression that either evaluates to true or false. The expression could be a
function that determines if the value entered in a cell is of numeric or text data type, if a value is
greater than, equal to or less than a specified value, etc

IF Function example

We will work with the home supplies budget from this topic. We will use the IF function to
determine if an item is expensive or not. We will assume that items with a value greater than
6,000 are expensive. Those that are less than 6,000 are less expensive. The following image
shows us the dataset that we will work with.

 Put the cursor focus in cell F4
 Enter the following formula that uses the IF function

=IF(E4<6000,"Yes","No")

HERE,

 "=IF(…)" calls the IF functions
 "E4<6000" is the condition that the IF function evaluates. It checks the value of cell

address E4 (subtotal) is less than 6,000
 "Yes" this is the value that the function will display if the value of E4 is less than 6,000
 "No" this is the value that the function will display if the value of E4 is greater than

6,000



When you are done press the enter key

You will get the following results



Excel Logic functions explained

The following table shows all of the logical functions in Excel

S/
N

FUNCTI
ON

CATEG
ORY

DESCRIPTION USAGE

01 AND Logical Checks multiple conditions and returns
true if they all the conditions evaluate to
true.

=AND(1 >
0,ISNUMBER(1)) The
above function returns
TRUE because both
Condition is True.

02 FALSE Logical Returns the logical value FALSE. It is
used to compare the results of a
condition or function that either returns
true or false

FALSE()

03 IF Logical Verifies whether a condition is met or
not. If the condition is met, it returns
true. If the condition is not met, it
returns
false. =IF(logical_test,[value_if_true],[
value_if_false])

=IF(ISNUMBER(22),"Yes",
"No")
22 is Number so that it
return Yes.



04 IFERRO
R

Logical Returns the expression value if no error
occurs. If an error occurs, it returns the
error value

=IFERROR(5/0,"Divide by
zero error")

05 IFNA Logical Returns value if #N/A error does not
occur. If #N/A error occurs, it returns
NA value. #N/A error means a value if
not available to a formula or function.

=IFNA(D6*E6,0) N.B the
above formula returns zero if
both or either D6 or E6 is/are
empty

06 NOT Logical Returns true if the condition is false and
returns false if condition is true

=NOT(ISTEXT(0)) N.B. the
above function returns true.
This is because ISTEXT(0)
returns false and NOT
function converts false to
TRUE

07 OR Logical Used when evaluating multiple
conditions. Returns true if any or all of
the conditions are true. Returns false if
all of the conditions are false

=OR(D8="admin",E8="cash
ier") N.B. the above function
returns true if either or both
D8 and E8 admin or cashier

08 TRUE Logical Returns the logical value TRUE. It is
used to compare the results of a
condition or function that either returns
true or false

TRUE()

Nested IF functions

A nested IF function is an IF function within another IF function. Nested if statements come
in handy when we have to work with more than two conditions. Let's say we want to develop a
simple program that checks the day of the week. If the day is Saturday we want to display "party
well", if it's Sunday we want to display "time to rest", and if it's any day from Monday to Friday
we want to display, remember to complete your to do list.

A nested if function can help us to implement the above example. The following flowchart
shows how the nested IF function will be implemented.



The formula for the above flowchart is as follows

=IF(B1="Sunday","time to rest",IF(B1="Saturday","party well","to do list"))

HERE,

 "=IF(….)" is the main if function
 "=IF(…,IF(….))" the second IF function is the nested one. It provides further evaluation

if the main IF function returned false.



Precision formatting
Care must be taken when working with formatted numbers. It is important to remember
that formatted numbers, i.e. the numbers which appear on the screen, may not be the
same as the value stored in the cell or the numbers used in calculations. The discrepancy
can causethe results displayed to be different from the manually calculated answers.

In the example opposite, there are two columns of numbers that
appear to be the same. The first column adds up to 95 but the
secondcolumn adds up to 100. Take a close look at the value stored
in cell A1, as displayed in the Formula bar. The value stored in all the
cells in the first column is actually 9.5. This has been formatted to
appear as a whole number (integer). The calculation is actually
correct (10*9.5=95), although it appears to be incorrect. The problem
can be avoided by using number formats cautiously, or it can be
resolved by setting the precision for the entire worksheet as
explained below.

Setting the precision of number formats
To set the precision of number formats for an entire worksheet:

1. Click the Office button , then select Excel Options button
2. Click on the Advanced category
3. Scroll down toWhen calculating this workbook

4. Choose the Precision as displayed box and click OK
When you choose OK you are warned that constant numbers throughout the workbook
willbe rounded permanently to match cell-formatting.
This will affect all cells in the worksheet. If you only want to round certain cells, then you
canuse the =ROUND function to round to a specific number of decimal places or the =INT
function to convert to an integer only.

Example:

The =ROUND function will round the contents of cell C6 to
2 decimal places, using mathematical rounding, and will
return7.57



Statistical & mathematical functions
Some of the most commonly used statistical and mathematical functions are shown below.

Function Example Description
MAX MAX(C1:C10) Finds the largest cell value in the specified range of cells.
MIN MIN(C1:C10) Finds the smallest cell value in the specified range of cells.
AVERAGE AVERAGE(C1:10) Finds the average cell value in the specified range of cells.
MEDIAN MEDIAN(C1:C10) Finds the median or middle value in the specified range

ofcells.
STDEV STDEV(C1:C10) Finds the standard deviation of the values in a range of cells.
COUNT COUNT(C1:C10) Counts the number of cells containing numbers.
COUNTA COUNTA(C1:C10) Counts the number of cells containing numbers or letters

(i.e.the number of non-blank cells).
COUNTBLANK COUNTBLANK(C1:C10) Counts the number of blank cells.
COUNTIF COUNTIF(

INT INT(C6) Returns the integer value (5.35 becomes 5, 7.34 becomes 7)
ROUND ROUND(C1, 2) Rounds the cell value to the specified number of

decimalplaces (2 in this example; use 0 to get a whole
number).

SQRT SQRT(C1) Calculates the square root of a cell value.
RADIANS RADIANS(C1) Converts angles from degrees to radians.
SIN SIN(C1) Calculates the Sine of an angle (in radians – use the

RADIANS function to convert degrees into radians).
Other trigonometric functions include COS and TAN.

Cell references
In functions, you often need to refer to a range of cells. The way Excel displays cell
references in functions depends on whether the cells you want the function to act upon
aretogether in a block, or in several non-adjacent cells or blocks.
The table below explains how to use different operators to refer to cells:

Operator Example Description

Reference
operator : (colon)

B5:B15 Range operator that produces one reference to all
thecells between two references, including the two
references.

, (comma) SUM(B5:B15,D5:D1
5)

Union operator that combines multiple references into
onereference.

(single space) =B5:B15 A7:D7 Intersection operator that produces one reference to
cellscommon to two references. In this example, cell B7
is common to both ranges; therefore the result would be
thecontents of cell B7.



Absolute cell referencing
The ability to copy formulae from one location to another in a spreadsheet can save you a
significant amount of work. Normally, if you copy a formula involving a cell reference to
another location, the cell reference is adjusted relative to its starting point. So, for example,
if you copy a formula which multiplies two cells to the left of it, the formula will adjust to the
new location by multipling the two cells to the left at the new position. Ie if you start a
formula is in C1 and multiply A1 by B1, and you then copy the formula to C2, the formula
willbecome A2 multiplied by B2, as these are the two cells to the left of C2. The formula
has updated automatically to refer to adjacent cells. This is an example of a relative
referencing system.
Sometimes we may need to refer to a specific cell location in a worksheet, and so we
wantthat cell reference to remain unchanged, regardless of where the formula is placed.
We need a method to fix our cell reference so that it does not update when we copy the
formulato another location – we need an absolute cell reference.

Making a reference absolute
If you type a $ sign before both the column letter and the row number of the cell
referencethen the relative reference A1 becomes the absolute reference $A$1. This
absolute reference won’t change if you copy the formula.
A beter method is the keyboard shortcut, F4. This is quicker and more accurate.

When constructing a formula and the cell which you want to make absolute is
selected,press the F4 key.

$ signs are automatically placed in front of the column and row references.

Absolute references explained
The data on the left show the basic earnings for a
group of staff. Their manager has decided to
award them a bonus payment, and wishes to
storethe total pay in column C.
The formula for cell C6 is =B6+$B$3. Here the $ is
used to make the reference to cell B3 absolute.
When this formula is copied into cells C7:C12,
theformula updates as shown.
Cell B6 in the initial formula is relative, therefore
this reference will change when copied, but B3 is
absolute and will not change to another
referencewhen copied.



A1 Relative

$A$1 Absolute

$A1 Mixed (Column Absolute, Row Relative)

A$1 Mixed (Column Relative, Row

Mixed references
If only the column reference or the row reference is to be absolute, prefix one or other
ofthese with a $ sign. For example, if the column is to be absolute and the row relative
A1becomes $A1, if the row is to be absolute and the column relative A1 becomes A$1.
1. Double-click in the cell as if to edit it.
2. Highlight the cell reference to be made absolute and press F4. Note that by pressing F4

a number of times you cycle through different options for creating a mixed reference.
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